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About this document

About this document
Purpose
This manual is intended as a guide to the installation and configuration for the MM8000
management stations that includes control units supporting the CDDL/CDSF protocol.
It presents the MM8000 Add-on module for the CDDL/CDSF support.
This guide is part of the general DMS8000 engineering documentation set which
includes the Composer Technical Manual, the other DMS8000 Connectivity Guides
(the complete list includes: Network, Fire, Intrusion, Access Control, Video, and OPC),
and the Installation, Configuration, and Commissioning manual (ICC) for each specific
product.

Scope
This document applies to the MM8000 Management Station MP4.60 and higher.

Target audience
This documentation is intended for the following users:


Project Managers



Project Engineers



Commissioning Personnel

It is assumed that individuals performing the operations described in this manual have
prior expertise and training in the field of safety and security, at least a moderate level
of familiarity with the Siemens Building Technologies product line, and experience with
the installation, configuration, and commissioning of security management systems.

Documentation resource information
The DMS8000 Documentation Resource Information and Glossary Guide assembles
important information regarding documentation resources. This document contains the
following:


Comprehensive definitions of the target audiences for Siemens FS DMS
documents



Training program information including the Siemens intranet link



A complete list of all available DMS8000 documents



Instructions for how to obtain a document via the Siemens intranet using the
Siemens Asset Portal



A map of relevant documents for each target audience group



Customer Support links & resources



A glossary containing definitions of all terms and acronyms used in DMS8000
documentation

To access the DMS8000 Documentation Resource Information and Glossary Guide
(document no. A6V10089056), go to the link and follow the document search
instructions below:
http://assetportal.bt.siemens.com/portal/index.html
1. In the Search column on the left, set:
-

Segment: 04 Fire -3F
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-

Document Type: All

-

Image Type: All

-

Advanced search criterias: Select Brochure No. and enter the document
number to search for (A6V10089056). Alternatively, select Title and enter the
product name (DMS8000).

2. Click Search to start.
3. In the resulting area on the right, click on Contents link to show the list of search
results.
For more information such as Siemens news and announcements, visit the STEP Web
portal at:
https://workspace.sbt.siemens.com/content/00001123/default.aspx

Operational and safety regulations
Before groups of persons begin work on the system, they must have read and
understood the Safety Regulations [➙ 7] section in this manual.

Liability disclaimer for damage or injuries
Before products are delivered, they are tested to ensure they function correctly when
used properly. Siemens disclaims all liability for damage or injuries caused by the
incorrect application of the instructions, or the disregard of danger advisories. This
disclaimer applies in particular to personal injuries or damage caused by:


Improper and/or incorrect use.



Disregard of safety instructions in the documentation or on the product.



Poor maintenance or a lack of maintenance.

We have checked the contents of this manual for agreement with the hardware and
software described. Since deviations cannot be precluded entirely, we cannot
guarantee full agreement. However, the data in this manual are reviewed regularly and
any necessary corrections are included in subsequent editions. Suggestions for
improvement are welcome.

Copyrights and registered trademarks
Brand or product names mentioned in this document may be names protected by
copyright law or registered trademarks of other companies. These are mentioned only
for identification purposes and have no recommendatory character in regard to the
product or manufacturer, unless otherwise stated.

Documentation Conventions
The following table lists conventions to help you use this document in a quick and
efficient manner.
Convention

Examples

Numbered Lists (1, 2, 3…) indicate a
procedure with sequential steps.

1. Turn OFF power to the field panel.
2. Disconnect the power cord.
3. Open the cabinet.

One-step procedures are indicated by a bullet



Expand the Event List.
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point.
Conditions that you must complete or must be
met before beginning a procedure are
designated with a ⊳.
Results, after completing a step or at the end
of the entire procedure, are designated with a
⇨.

⊳ The report you want to print is open.

Bold font in a procedure indicates something
you should select or type.

Type F for Field panels.
Click OK to save changes and close the dialog
box.

Menu paths are indicated in bold.

Select File > Text, Copy > Group, which
means from the File menu, then select Text,
Copy and finally Group.

Error and system messages are displayed in
Courier New font.

The message Definition successfully
renamed displays in the status bar.

Italics are used to emphasize a term.

The Open Processor continuously executes a
user-defined set of instructions called the
control program.

1. Click the Print icon

.

⇨ The Print dialog box appears.
2. Select the printer and click Print.
⇨ The print confirmation appears.

This symbol signifies a Note. Notes provide
additional information or helpful hints.
Caution

This is a Caution message and indicates that
minor or moderate injury or property damage
may occur if a procedure is not followed.

Warning

This is a Warning message and indicates that
a serious injury or a severe equipment and
property damage may occur if a procedure is
not followed.

Cross references to other information in
printed material are indicated with an arrow
and the page number, enclosed in brackets:
[→92]

For more information on creating flowcharts,
see Flowcharts [→92].

Modification index
Note: For versions more than four years old, please visit the Siemens Asset Portal.
Version

Date

Notes

A6V10067787_a_en

06.2013

DMS8000 4.60.
Installation procedure for versions older than version
4.15 has been removed.

A6V10067787_a_en

06.2009

DMS8000 4.20.
New Add-on Manager for software installation.
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1 Safety regulations
This section describes the danger levels and the relevant safety regulations applicable
to the use of the products described in this manual. Please read the following work
instructions as well as the preceding section About this document thoroughly before
beginning any work.

1.1

Country-specific standards
Siemens products are developed and produced in compliance with the relevant
international and European safety standards. Should additional country-specific, and/or
local safety standards or regulations concerning project planning, installation, and/or
operation of the product(s) apply, then these standards and/or regulations must also be
taken into account, in addition to the safety regulations mentioned in the product
documentation.

1.2

1.3

Commissioning and testing


Activate security-, fire- and third party systems or devices only in the presence of
the person responsible.



Abide by the safety regulations of the connected sub-systems when working on
management stations. This especially applies when switching-off system
components.



Inform people before the testing of alarm devices; take the possibility of panic
reactions into account.



Inform the alarm and fault receiving stations connected to the system before
carrying out any tests.

Modifications to system design and products
Modifications to a system or to individual products may cause faults or
malfunctioning.
Please request written approval from Siemens Building Technologies, FS-DMS, and
the relevant authorities concerning intended system modifications and system
extensions.
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2 Introduction
CDDL/CDSF protocol
Some of the FS-DMS legacy subsystems and a number of 3rd party units have applied
the CDDL/CDSF protocol suite to exchange application messages with LMSmodular
management station.
The CDDL (Cerberus Dati Data Link) is a data-link protocol specifying the data
exchange across a serial RS232 point-to-point connection.


For more information about CDDL, please refer to document CDI-135-017-E.

The CDSF (Cerberus Dati Data Format) defines the data structure of application
messages transferred into CDDL frames. CDSF is designed to model the control unit
conditions into a flat list of multi-state objects that can be easily mapped into the
process image memory of central stations.


For more information about CDSF, please refer to document CDI-130-017-E.

CDSS subsystems
Control units that can communicate via CDDL/CDSF are generally called CDSS
subsystems. CDSS is an acronym for Cerberus Dati Standard Subsystem.
Each unit type applies the CDSF standard according to a specific model, including a
point and command map.

CDDL/CDSF add-on module
WARNING
It must be made clear that the MM8000 add-on module documented here is not a
ready-to-use solution and is intended as an open toolkit that allows for integrating
CDSS subsystems via NK82xx. Each subsystem requires in fact that a specific CDSF
application model that is defined and configured using the CDSS Meta Subsystem
Tool utility.
In fact, depending on the modelling solutions, multiple applications of the protocol may
exist for the various control units. A customisation tool is provided in the MM8000 addon, along with the communication and configuration software, in order to adapt each
system to the actual installed units.

Version supported
In general, CDDL exists in a unique version, whereas there are two implementations of
CDSF: one is fully compliant to the standard (document CDI-130-017-E), whereas a
variant (e.g. CP100 gas unit) specifies a different format for the first byte of commands
(00 hex instead of the standard 80 hex).
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What's new
Here is the list of modifications for new functions and software improvements.
Section

Modifications

N/A

N/A
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3 Installation
3.1

Add-on distribution package
The MM8000 software for the control unit support is distributed as an add-on package,
to be installed on the stations including the Composer tool (client-only and FEP
stations are therefore excluded) after the standard MM8000 Setup.
The package is named MM8000 MPx.xx.xx - System Extension N.06 (CDSS Vy.yy)
and is made up by an installation kit of a few files.

Installation kit
The installation kit includes:


Custom folders, containing the customisation tool for the specific application.



The new Help Files, describing the control unit configuration procedures.



The new Composer Subsystem Tool (New ST) for the control unit models.



The firmware for the NK82xx units (NK822x Firmware), i.e. the DLL module
supporting the control unit protocol.



The Poseidon Files, including the definitions of the control unit data structures.



The registry file folder (Reg Files), containing a command for registering the add-on
package.



The installation utility: the MM8000 – Extension Installation.exe program (managed
by the Add-on Manager).



The extension name text file; e.g.: MM8000 – Extension Product Name.txt.

Installation kit

3.1.1

Installation checklist
Items needed for the installation


The MM8000 Setup DVD



The MM8000 MPx.xx - System Extension N.06 (CDSS Vy.yy) installation kit



The MM8000 hardware key (dongle)



The MM8000 license PAK code (or the REG file that contains it)

Installation checklist
1. Install the MM8000 Software and the required license key and PAK.
Refer to MM8000 Installation, Configuration and Commissioning Guide and

Release Notes

10
Building Technologies
Fire Safety & Security Products

A6V10067787_a_en
30.06.2013

Installation
Software installation

3

2. Install the NK8000 units (NK82xx).
Refer to NK8000 Installation, Configuration and Commissioning
3. On the station(s) with configuration capability (Composer tool), install the add-on
module [➙ 12].
4. Customise the model [➙ 13] according to the modelling solution.
5. Update the NK8000 firmware [➙ 19].

3.2
3.2.1

Software installation
Requirements
This add-on does not add any special requirements to the standard MM8000 setup.
Therefore, software and hardware requirements are described in the MM8000
Installation, Configuration and Commissioning manual (A6V10062413) and in the
NK8000 Installation, Configuration and Commissioning manual (A6V10062437).
The MM8000 software must be properly installed before the add-on can be installed.
For more information on the MM8000 installation, please refer to the MM8000
Installation, Configuration and Commissioning manual (A6V10062413).

3.2.1.1

MM8000 compatibility
This add-on package is designed to work with MM8000 MP3.20 and higher. Contact
FSP-DMS support to verify the compatibility with other versions.

3.2.2

Software License
An additional license is required to run the add-on module. On top of the base MM8000
license codes, a specific PAK is therefore needed.
Therefore, the required license includes:


WW8000 Composer (project configuration and download): Composer License or
Service key.



NS8210 driver: NK8000 connections, indicating the number of NK82xx units.
This license is required for enabling the network driver and the NK82xx units
communicating with the control units.



MM8000 core, no. of subsystems.
This license should include the number of control units.



MM8000 core, no. of devices.
This license should include the number of physical objects (detectors, auxiliary and
control outputs).



Add-on license.
Check detailed sales policy for your country

Other licenses, covering more MM8000 options, may or may not be used and they are
not related to the add-on support.
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3.2.3

Installing the Add-on module
The following is the installation procedure for the add-on module.
WARNING
Add-on versions older than MP4.15 require a different installation procedure; for such
cases, please refer to the add-on manual of the corresponding version.

3.2.3.1

Installation on MM8000 MP4.15 and later
A specific application – the Add-on Manager – is provided starting from MM8000
MP4.15, and allows installing and updating the add-on modules. The application
supports the installation of add-ons developed for all MM8000 versions starting from
MP4.15.
The following are the installation procedures for the add-on module.
1. Start the Add-on Manager.
-

From the Windows Start menu, select the following:
Start > DMS8000 > Tools > Add-on Manager
 The Add-on Manager window appears.
2. In the list of MM8000 Add-Ons/Name, select the name of the module you wish to
install
-- OR – (if the name of the add-on is not in the list on the screen):
click Browse, locate the installation files of the add-on module, and select the text
file (Extension Product Name.txt) in the root folder.
3. If your installation includes a customized MM8000 internal account, then deselect
the check box Use default MM8000 User account and specify the customized
username and password.
Note: For information about the MM8000 Internal Account, refer to MM8000
internal user account section of the MM8000 ICC, doc.no. A6V10062413_a_en.
4. Click Install (or Update if a previous version was detected).

3.2.3.2

Multiple add-on’s installations
In general, it is possible to install multiple add-on packages and benefit of their
combined functionalities. However, specific incompatibilities might exist. Please check
about possible problems in the documentation of all add-on modules that must be
installed.

3.2.4

Removing the Add-on module
Add-on module cannot be uninstalled.
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Model customisations
The CDSF standard (refer to document CDI-130-017-E, edition 01.1994) defines a
general message structure which can be applied to any data communication involving
a set of multi-state variables.
In MM8000 applications, the protocol can be used using a 3-step approach:
1. Meta-model definitions
A general set of meta-model definitions have been defined in the web-based
Poseidon modelling environment (refer to FS-DMS document 2004-0217-00-Eng).
The meta-models, typically organised per discipline (e.g. fire units meta-model),
comprise a superset of all the applicable objects.
Note: The Poseidon’s meta-models are the base for any further steps. If the
available meta-models are somehow not sufficient for a specific application, please
contact the customer support in order to define new requirements.
2. CDSS Customisation tool
The meta-models can be applied in the CDSS customisation tool, which is included
in the add-on package, whose task is to define applicable Composer models for the
CDDL/CDSF compatible units, i.e. creating CDSS subsystem models.
The Composer models can make use of the meta-model objects, freely allocate
them in the CDSS subsystem model structure and finally link the objects states to
the actual protocol messages. The result of this task consists of data files for
Composer and NK8000 devices.
3. Composer
In Composer, once the model data file is available, the CDSS subsystem model
can be applied in the MM8000 projects: the model objects are instanced as datapoints for mapping the corresponding states (or CDSF messages) of a real control
unit.
Note that this document does not discuss the step 1, which requires a specific training.
Instead, step 2 is presented in the next section, whereas step 3 is a typical Composer
configuration [➙ 22].
Depending on the specific installation, the CDSS subsystem model may be already
available for your specific requirements. In this case, just proceed directly to the
Configuration [➙ 22] section.
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3.3.1

Customisation tool
The tool is a Windows program named CDSS Meta Subsystem Tool.exe, which is
available in the folder:
<Installation folder>\DMS8000\Composer\Configuration Data\OTD_Files\
Note: <Installation folder> is usually C:\Program Files\

3.3.1.1

User Interface
Starting the program, the following window appears. The tool interface is organised in
three parts:


On the top, an area where name and type of the selected model are shown; also,
some general configuration flags are present here.



In the middle, the objects list is defined and the states of each object can be
associated to protocol messages.



In the lower part of the window, the control commands can be associated to
equivalent protocol commands.

A

B

C

CDSS tool interface

A

Model general data

B

Object list and CDSF association rules

C

Command list and CDSF association rules
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Configuration fields
Control Unit Settings
Description

Name of the model currently opened: a free text

Discipline

Application discipline, which defines the meta-model that is
applied and the correspondent superset of object list. Note
that, after you define a specific object to be part of the model,
the discipline can no longer be modified.

State Propagation Support

If set, this checkbox enables the propagation of states along
the tree structure of objects.
Note: This state propagation is implemented in the NK82xx.
When used for the MM8000 management station, which can
also provide the same propagation function, this option should
not be set. Instead, solutions including the MK800 OPC server
or other host systems may benefit of this feature.

Standard

If set, it enables the standard CDSF command formatting,
which defines the first byte of commands being = 80 Hex), else
the first byte is set = 0.
Refer to CDDL/CDSF add-on module [➙ 8] section.

Version

Field available to store a model version number; no check is
executed on the value.

Object List
This is the large white space on the left part of the window. It lists the meta-model
objects available for the given discipline; any subset of the list can be actually applied
in the model.

Object Settings
Parent settings

Referring to the object type currently selected in the Object
List, select here the parent node for the specified range of
CDSF points.

From/To/Point Number

Referring to the object type currently selected in the Object
List, enter the point range and the related parent point number
according to the CDSF point list.

MetaStates Configuration

Referring to the object type currently selected in the Object
List, enter here the information about the available states:
State definition (Meta State), Associated Command (ID
Command 1 to 3), and CDSF State Number (a number ranging
from 0 to 15). This table creates the actual conversion table
between CDSF states and DMS8000 states (CNAP protocol).

Meta Commands
Configuration

Enter here the information about the available commands:
Command Definition, Command Number, Command
Parameters (up to 5), associated Object Type.
Command parameter can be:
 Fixed: Select this option and then specify the fixed value
you want to set.
 Point Address: The involved point index is used as
parameter (absolute point addressing; e.g. the value 25 is
used to command CDSF point 25).
 Single Range Offset: The point index referred to the type
offset is used as parameter (relative addressing; e.g.: the
15
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value 5 is used to command Zone 5 corresponding to
CDSF point 25, assuming the zone type starts at index
21).
 Full Range Offset: Same as previous, but capable of
handing multiple offset ranges (relative addressing; e.g.:
the value 15 is used to command Zone 15 corresponding
to CDSF point 55, assuming the zone type ranges from 21
to 30 and then from 51 to 60).
 Parent Point: The parent of the involved point is used as
parameter (absolute point addressing).
Associated Object Type can be:
 All: All points can be affected by this command.
 <Specific Object Type>: The command can only affect the
specified type.

Example of configured unit
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Main menu
The tool menu includes the following commands:

File
Open

Open one of the existing models, which are stored in .CUB files, located
in the same folder as the tool program.
Note that a new model can be added by simply typing its name in the
Description field, filling in the information, and then saving it.

Save

Save the model into the .CUB file on disk.

Exit

Close the tool program.

Configuration
Show tree

In the object list field, display the hierarchical structure of the list.

Hide tree

In the object list field, display the plain list.

Help

3.3.1.4

About CDSS tool

Show general information about the program.

Help page

Show the help page.

Configuration procedure
To configure a model, you should proceed as follows:

Preparing the model
1. Get the detailed point and command list for the specific control unit, including the
possible states and the command parameters.
2. Study the possible relationships between CDSF points and the objects available in
one of the Poseidon meta-models (see Annex A [➙ 27]).

Configuring the model
1. Open the CDSS Meta Subsystem Tool.
2. Define a new model entering the name in the Description field.
3. Select the Discipline, thus setting the meta-model.
4. If the model should have a tree structure and propagation is required along the
tree, check the State Propagation Support option.
5. Depending on the CDSF compatibility [➙ 8] of the specific unit, select or not the
Standard option.
6. Enter the version number, e.g. V1.0.
7. Select the Panel object (whose configuration is mandatory) in the Object List.
17
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8. Select the CDSF point range (From/To) associated to the Panel object.
Typically, this is a single CDSF point (From = To) representing a general summary
of the control unit status. Leave the (parent) Point Number = 0.
9. In the Configured States list, add the required lines according to the possible
conditions of the CDSF point.
10. For each state, define the associated commands (ID Com) and the CDSF Value.
Note that CDSF Message Type is usually =0.
11. Enter the required commands and related parameters.
12. In the Object List, select the next applicable object type.
Note that the points named Physical Tree and Logical Tree cannot be associated
to CDSF messages as they are only used for collecting other objects into a
physical or logical oriented structure.
13. Select the CDSF point range (From/To) associated to the object type.
It may be one or more points. Also, if a tree structure is used, enter the parent
Point Number for this object range (e.g.: the point associated to the Panel object)
as well as the parent object (Parent Setting). Note that consistency is required
between the parent settings.
14. Define states and commands (see step 8 and 9 above).
15. Repeat steps 12 to 14 for all the necessary object types.
16. Save the model (menu File > Save).
When a new model is defined, new files (*.CUB and *.BIN) are available for handling
the new CDSS unit in Composer and NK82xx, respectively.

Installing the model
At this point, Composer is ready to operate with the new model, whereas the NK82xx
devices require a download, as described in the Downloading NK82xx firmware [➙ 19]
section.
WARNING
Be aware that any subsequent change in the model is taken into account by
Composer in any further configuration step.

3.3.2

Control unit icon
A specific icon can be defined for representing the control unit in the Composer (and
MM8000) tree. The configuration tool provides for a default icon, which is named after
the Description name of the new model.
A customised file can replace the standard ICO file. We recommend the following
format:


ICO file; resolution 48x48: colour depth 32.
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Communication network
The control unit is connected to the MM8000 system by means of the NK8000 network
and namely via the NK82xx units.
In order to communicate with the control unit, the NK82xx units should however be
equipped with a new firmware that is included in the installation package as an
additional component (DLL) to be added to the standard firmware file set.
The software installation procedure provides to copy the firmware files (a compressed
ZIP archive) in the NK82xx – Firmware folder of the MM8000. From there, the files can
be downloaded to the NK82xx units using standard Composer commands. The
required procedure is described here below.

3.4.1

Downloading NK82xx firmware
The following are the download procedures for the NK82xx firmware supporting the
control unit communication protocol.
Note: It is assumed that the NK82xx are physically installed, powered on, and
communicating over the network. For more information about the NK8000 installation,
please see the document no. A6V10359485, DMS8000 Connectivity Network guide.
More advanced technical issues are also discussed in the document no.
A6V10062437, NK8000 Installation, Configuration and Commissioning.
Also, you should have available the Composer project that includes the NK8000
network and all the NK82xx units.

Verifying the connection with NK82xx
The NK82xx download requires that the TCP/IP connection between the host PC and
the NK82xx is working properly.
In the Windows Command Prompt window, you can check easily this connection using
the Ping command:


Ping n.n.n.n
where n.n.n.n is the IP address of the NK82xx unit, e.g. 168.123.8.76.
If the IP connection is good, the message text looks like the following example:

Checking IP connection


Reply from n.n.n.n: bytes=… time … TTL=…
If the IP connection is not working for any reason, different messages may appear
(Request timed out, Destination net unreachable, etc.) In these cases, verify the
network settings and cabling and try again.

Downloading the NK82xx firmware
1. Start Composer and open the project that includes the control units.
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2. Expand the Channel collection folder in:
Supervision System Settings > MM8000 System > Physical configuration > Station
(or FEP) > Channel collection
3. Select the NS8210 driver node and then the Download tab.

Download tab

4. Select all the branches (NK82xx) in the list located in the upper part of the form.
Note: In order to select multiple branches, keep the CTRL key pressed while you
make your selections. See the following:

Selecting the NK82xx

5. Add the new firmware version:
a. Click Add, then browse and locate the additional firmware file in:
<MM8000 installation folder>\NK82xx – Firmware
b. Click the zip file: NK82xx_<add-on>__x.xx-xx, with x.xx-xx being the software
version.
c. Click Open.
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 In a few moments, the new firmware shows in the Firmware List.
The _0x suffix in the firmware name indicates the add-on index.

6. Select the new firmware version in the Firmware List.
7. Click the Download Firmware button.
 The download procedure starts. The new firmware is downloaded to the
NK82xx units via FTP (File Transfer Protocol) services over the network.
8. Ensure that you have successfully completed all downloads.
Verify that the FW Downloaded check boxes contain X’s.
That completes the NK82xx firmware download.
Note that the NK82xx configuration will also need to be downloaded after having
configured the control units in Composer.
Downloading multiple firmware
In case multiple add-on packages have been installed, then all the associated
firmware files can be safely downloaded in sequence (each of them being a single
additional DLL) as long as the base NK82xx version is the same. Please check the
firmware version in the firmware list before selecting the file to download. Also, get
informed about latest compatibility issues in the most recent NK8000 Release Notes.
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4 Configuration
4.1

Configuration checklist
Verify that you have satisfied the items needed in the first checklist before proceeding
to the configuration checklist that follows.

Items needed for configuration


The number and model of CDSS systems.



The local address (0 to 65535) for each unit.



Exact information on the CDSS internal configuration.



The exact connection to the NK8000 unit (NK82xx).



Plug-ins needed:
–

Plug-in #356201

Note: Plug-ins are installed during the software setup procedure. You can check that
the Plug-ins are actually available using the Composer Plug-in Installer in the
DMS8000 start menu.

Configuration overview
1. If not already done, install the new NK82xx firmware.
2. Add the folder(s) required for identifying the location of the CDSS in the project
structure tree.
3. Add the CDSS control unit node to the new folder.
4. Set the Local Address.
5. Configure the objects manually.
6. Link the CDSS to the communication network.
7. Set the communication baud rate.
8. Repeat steps above for all the CDSS units in the project.
9. Download the configuration.

4.2

Configuration procedure
The following are the configuration procedures for the CDSS control unit:

Adding the folder for the CDSS system
1. Open the Composer project.
2. Create a folder for the control unit.

Adding the CDSS node
1. Select the new folder.
2. Select the CDSS icon

and select the model, which can be one of the customised

models currently available.
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 The new node is added to the project structure.
Note: You can customise the default name of the new node typing in a new name in
the Description field of the Node tab.

Adding an CDSS subsystem

Setting the CDSS Local Address
1. Select the CDSS node.
2. Click the Node tab.
 The Node form page shows.
3. In the Node tab form, you can find:
-

Description text: the node name you also have on the project structure tree.

-

Technical Text: the technical name of the node (read-only).

-

Unit Local Address: the CDSS address, ranging from 0 to 65535.

4. Set the unit Local Address.
Note: The Local Address should match what is set in the control unit.
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Setting CDSS mode (subtype) and the unit Local Address

Manual configuration
You can configure the CDSS unit to reflect the actual field configuration. Object types
and ranges depend on the model definitions.

Linking the Communication network
1. Open NK82xx sub-folders.
Expand the NK8000 network folders until you reach the node that represents the
NK882x COM port that is physically connected to the control unit.
2. Select the control unit node.
3. Drag and drop the control unit node to the network COM port.

Note: Composer helps you in recognising a valid link by showing a shortcut Link icon
instead of the circle No-link icon

.

Linking CDSS to the NK8000 network

When the link is established, a new node appears on the structure tree, and its
properties can be seen on the Link tab of both the connected nodes.
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Setting the communication baud rate
1. Select the new link node just below the NK82xx serial line node.
2. In the Node tab, set the communication baud rate, which must match the
corresponding setting in the control unit.

Setting the baud rate

Downloading the MM8000 configuration
Before operating with the new MM8000 configuration, you need to download it. In
Composer, the download command is available in the Tools menu. The preparation to
the download is discussed in the document no. A6V10062413, MM8000 Installation,
Configuration and Commissioning.

Downloading the NK82xx configuration
After any modifications on the control units, a new configuration download is required
for the NK82xx devices.
WARNING
The NK82xx units handle the control unit messages interpretation for MM8000. In
order to do so, the NK82xx needs to be downloaded with the updated configuration of
the management stations, even after a minor modification to the subsystem structures
(e.g.: after having imported an updated metafile including new objects).
Depending on the specific configuration change, failing to download the NK82xx units
may affect the correct behaviour of the telegram interpretation and result in missing
event signalling. In general, we recommend including an NK882x download after any
change in the configuration.
The download procedure can be started in two ways:
1. In the Download tab of the NS8210 driver node:
-

Select:
Supervision System Settings > MM8000 System > Physical configuration >
Station (or FEP) > Channel collection > NK8210 driver

-

In the list that shows up, select the NK82xx units.
Note: In order to select multiple branches, keep the CTRL key pressed while
you make your selections.

-

Click the Download Configuration button.
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-

Ensure that you have successfully completed all downloads.
Verify that the Cfg Downloaded checkboxes contain X’s

2. In the NS82xx node (select all units one after the other):

4.3

-

Right click the node.

-

In the menu, click Node commands > Download file CNF.

Configuration backup and restore
The standard Backup and Restore functions in Composer provide for saving the
CDDL/CDSF customized models [➙ 14] along with all the project data.
Note that the entire folder OTD_Files is actually restored in
<installation folder>\Composer\Configuration Data\
and this also includes the model customisation tool (CDSS Meta Subsystem Tool.exe).
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Annex A – CDDL/CDSF meta-models
The following meta-models are provided for direct use or further customisations:


CP100 gas detection unit



AVOTEC fire alarming unit



PATROL intrusion detection unit
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